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Preface

Welcome to the Licensing Guide. This guide contains information about how to

install an IAR product that uses a network license, and how to manage

network, mobile and PC-locked licenses. This guide also contains reference

information on the IAR License Manager.

For information about how to install and license an IAR product online that

uses a mobile or PC-locked single-user license, see the Installation and Licensing
Quick Reference Guide.

Who should read this guide

You should read this guide if you:

Are about to install a network license and need more information than is available in
the Installation and Licensing Quick Reference Guide

e Are about to renew your existing license

e Need to transfer your license to another computer offline

Are about to use the IAR License Manager.

What this guide contains

This guide contains these chapters:

Introduction gives a general introduction to the installation and licensing procedure,
and describes the differences between the three license types with the main focus on
network licenses.

Installation gives a step-by-step description of how to install an IAR product that
uses a network license.

License management gives step-by-step descriptions of how to perform some
typical tasks when managing your licenses.

Reference information gives reference information on the IAR License Manager—a
tool for managing your licenses.

Licensing concepts lists and describes terms related to licensing in general.
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FURTHER INFORMATION

If this guide does not answer your questions or solve your problems concerning
installation or licensing, you can:

o Read the Release notes for recent information that might not be included in this
guide. The Release notes for IAR products are available in the Information Center
and from the installation wizard. The Release notes for the IAR License Server
Tools are available from the installation wizard.

e See the technical notes on the Technical Support pages on the IAR web site,
www.iar.com/support.

o Go to www.iar.com/customercare and view FAQ for answers to questions about
licenses, product updates, evaluation versions, and registrations, or contact IAR
Customer Care, preferably with collected diagnostic information.

If you contact our Technical Support, be prepared to provide the following information:
your license number, the type of license lock you use, when and where you purchased
the product, and a detailed description of the problem.

Command line instructions

For instructions on how to install and update IAR Build Tools, or how to manage
network licenses with IAR License Server Tools from the command line on Linux or
Microsoft Windows systems, see the Installation and Licensing Command Line User
Guide included in your product.

Document conventions
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When referring to a directory in your product installation, for example \doc, the full
path to the location is assumed, for example c: \Program Files\IAR
Systems\Embedded Workbench N. n\ cpuname\doc, where the initial digit of the
version number reflects the initial digit of the version number of the IAR Embedded
Workbench shared components.

TYPOGRAPHIC CONVENTIONS
The IAR documentation set uses the following typographic conventions:

Style Used for

computer * Source code examples and file paths.
* Text on the command line.
* Binary, hexadecimal, and octal numbers.

Table 1: Typographic conventions used in this guide
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Style Used for

parameter A placeholder for an actual value used as a parameter, for example
filename.h where filename represents the name of the file.

bold Names of menus, menu commands, buttons, and dialog boxes that
appear on the screen.

italic * A cross-reference within this guide or to another guide.
* Emphasis.
An ellipsis indicates that the previous item can be repeated an arbitrary
number of times.
Identifies helpful tips and programming hints.

El

Identifies warnings.

Table 1: Typographic conventions used in this guide (Continued)
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Introduction

This chapter introduces the IAR licensing system, giving an overview of the
installation and license activation procedure, and of the different license types.

How IAR licensing works

Each product from IAR comes with a software license and a license number, which is
found in the welcome letter of your product package.

When you start your IAR product for the first time after it has been installed, you can
use your license number to activate your temporary startup license. This license allows
you to start using the product immediately after installation and 30 days onward.

The License Wizard will guide you through the process:

Enter Register Activare Receive Activare
license your startup email permanent
number product license netification license

Install Start
product product

When you have finished the purchase of your product, you will receive email
notification from IAR that your permanent license is now available. You can then
activate your license for permanent use. With a permanent license, you are also entitled
to up to one year of free updates and prioritized technical support, depending on your
purchased product.

The IAR License Manager is automatically installed when you install your AR product
or the IAR License Server Tools, and is used to manage your licenses on both license
servers and client computers. For more information about how to use the IAR License
Manager, see License management, page 25.
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LICENSE TYPES
There are three types of permanent licenses:

® Mobile license—a single-user license locked to a dongle (hardware lock). A dongle
is a device you attach to the computer’s USB port, which allows you to easily move
the license to another computer by just moving the dongle.

® PC-locked license—a single-user license locked to the computer where the product
is installed.

® Network license—a multi-user license located on a license server and used by
multiple users on a network. The network license is locked to either to the computer
where the license server runs, or to a dongle (hardware lock).

BRIEFLY ABOUT THE IAR LICENSE MANAGER

The IAR License Manager is a program—automatically installed when you install your
IAR product or the IAR License Server Tools—that you use to manage your licenses.

The IAR License Manager is local to a specific installation directory and automatically
detects all IAR products that use this version of the licensing system and are installed in
the same directory.

You can start the IAR License Manager either from the Windows Start menu or from
the Help menu in your IAR product.

BRIEFLY ABOUT THE LICENSE WIZARD

The License Wizard leads you step by step through the license process. The wizard starts
automatically when you start your IAR product, if there are installed products without
valid licenses. You can also start the License Wizard through various options in the
License menu in the IAR License Manager.

Network licenses
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A network license is a multi-user license that is located on a license server computer and
used by multiple users on a network. A license server computer is a PC with the AR
License Server Tools installed. Individual installations of IAR products are installed on
other client computers in the same network.

The network license makes it possible to use your IAR product from any of the client
computers on the network. The network license allows for a maximum number of
concurrent users, and the license server keeps track of the current number of users.
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The network license is locked to the computer where the license server is installed,
either to the computer itself or to an attached dongle (hardware lock). With the dongle,
you can easily transfer the license server to a different license server computer.

The license server is generic and you can use it for all IAR products you install.

THE IAR LICENSE SERVER TOOLS PACKAGE
When you order a network license, you receive:

e Your IAR product

o The IAR License Server Tools

e A welcome letter.

If explicitly ordered, you also get one dongle.

IAR License Server Tools
The IAR License Server Tools are:

o The /AR License Manager for License Server—used for managing licenses on
either the license server or client computer. The IAR License Manager is
automatically installed when you install the IAR License Server Tools.

o The Sentinel RMS License Manager—the actual license server.

You install the IAR License Server Tools on a computer that you want to use for the
license server.

YOUR IAR PRODUCT
Your IAR product can be installed on as many client computers as you want.

Using a network license, the IAR product requests permission from the license server
when you perform an activity that requires a license to run, for example compiling and
linking.

When the activity is finished, the permission to use the network license remains locked
to that client for another 30 minutes before it is released to another client. You can view
the status of the license in the IAR License Manager.

The requested license is cached on the client. The cache is valid for 20 minutes, during
which no contact between the client and the license server is needed. When the cache
expires, the license is still reserved to the client for another ten minutes. If the client
makes a new license request within those ten minutes, the license becomes locked to the
client for another 30 minutes, and cached for another 20 minutes.
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USING DIFFERENT VERSIONS OF THE IAR LICENSE SERVERS
TOOLS

Your IAR product requires version 2.x of the IAR License Server Tools.

Note: Some IAR Embedded Workbench products require version 1.4x or older of the
IAR License Server Tools. A version 2.x and version 1.x installation of the IAR License
Server Tools cannot coexist on the same computer.

CLIENTS WITH COMMUTER AUTHORIZATION

A network license includes a commuter feature, which makes it possible to use your [AR
product for a limited number of days without being connected to the license server. For
more information, see:

o Checking out a product for commuter authorization, page 34

o Setting the maximum number of commuter authorizations, page 34.

SYSTEM REQUIREMENTS

For information about systems requirements:

e For the license server computer (network licenses only), see the Release notes for
the IAR License Server Tools available from the installation wizard.

e For client computers, see the Installation and license activation section in the

Release notes available in the Information Center and from the installation wizard.

Note: If you use the same computer as both a license server and a client computer, some
types of files that are created by both the server and client, for example diagnostics
reports, logs, and so on, will be overwritten by the other application.

Note: To install and activate an IAR product, you must have administrator privileges on
the computer, and an internet connection. If the license server computer does not have
access to the internet, see Activating a license when offline, page 35.

NETWORK REQUIREMENTS

To use a network license, you need a stable connection between your license server
computer and your client computer with appropriate network configurations.

These network settings are required:

o Allow HTTPS traffic on port 443 and set the internet proxy ON on your license
server for online license management, for example license activation, renewal, or
de-activation.

The IAR License Manager uses the HTTPS communication protocol to fetch license
keys from IAR.
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e Open UPD Port 5093 for inbound and outbound traffic on both your license server
and client computer.

The client/server communication is handled via the UDP port 5093 on an IP network.
If afirewall or network bridge is installed on the license server computer, for example
Windows Firewall, UDP packets must be allowed to be routed through server port
5093.

UDP broadcast packets at port 5093 are also used every time your IAR product is
started, and periodically for as long as the IAR License Manager is running. The
broadcasts are made to find available license servers on the network. No broadcasts
are made during the time that a licensed product is being used.

o The server computer must have a static TCP/IP address.

e Only IPV4 is supported.

e If the broadcast function is not available in your network configurations or your
license server is on a different subnet, manually point out the server from the client.
For more information, see Choosing a network license server manually, page 30.

e If your license server computer has multiple-IP systems, it is recommended to either
use a single-IP system for your server computer, or to configure your firewall to

allow your client computer to communicate on multiple IP addresses from your
Server.

For more information, see
https://www.iar.com/knowledge/support/technical-notes/licensing/.
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Installation

This chapter gives information to a system or network administrator about
how to install IAR products that use a network license, which includes
installing the IAR License Server Tools on a designated server computer and
an |IAR product on client computers.

For information about network licenses, see Network licenses, page 10.

Installing network licenses

To install an IAR product with a network license, follow this procedure:

A Install the IAR License Server Tools on a server computer. (Omit this step if
the latest version of the IAR License Server Tools is already installed.)

B Activate your temporary startup network license using the IAR License
Manager on the server computer.

C Activate your network license for permanent use. Perform this step when you
receive notification from IAR that your permanent license is available.

D Install your IAR product on the client computers. Repeat this step for each
client computer.

Note: To install products from IAR, you must have administrator privileges to the
system.

A.INSTALL THE IAR LICENSE SERVER TOOLS

Important: Before installing the IAR License Server Tools, you must choose a suitable
computer to use for the license server. See the system requirements described in the
Release notes for the IAR License Server Tools.

Note: Your product version requires version 2.x of the IAR License Server Tools. Some
IAR Embedded Workbench products require version 1.4x or older of the AR License
Server Tools. A version 1.x and version 2.x installation of the IAR License Server Tools
cannot coexist on the same computer.

Note: If the latest 2.x version of the IAR License Server Tools is already installed, you
can proceed to B. Activate your temporary startup license, page 16.
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To install the IAR License Server Tools:
Remove any USB dongles.

Run the IAR License Server Tools installation program (autorun.exe).

Click Install the IAR License Server Tools. This will first install the IAR License
Manager and then immediately continue with the Sentinel RMS License Manager.

Follow the instructions provided in the installation wizards and accept the license
agreements when prompted.

Configure your firewall to allow inbound traffic on UDP port 5093 (if this was not
done by the server installer).

Normally, when the IAR License Manager for License Server is installed, you do not

need to start the license server manually. It will automatically start after the installation,
and restart every time you restart the computer. If for some reason you need to start the
license server manually, see Starting and stopping a license server manually, page 32.

B. ACTIVATE YOUR TEMPORARY STARTUP LICENSE

When you activate your network license, you are given a temporary startup license that
allows you to use the product immediately after installation and for 30 days onward.
When you finalize your IAR product purchase, you will be notified that your permanent
license is available.

If the license server computer does not have an internet connection, you can activate
your license offline, see Activating a license when offline, page 35.

Note: Two network licenses for the same IAR product and package cannot coexist on
the same license server, with the later activated license overwriting the previous one.
The previous license can be reactivated on the same computer with the same locking
criteria. If you want to add more users to a network license, contact your IAR Sales
office.

To activate a temporary startup network license:

On the license server computer, start the IAR License Manager for License Server from
the Windows Start menu.



2 Choose License>Activate License to start the License Wizard.

-
) IAR License Manager 217.2 - License Server

= | B [ |

File View | License | Tools Windows Help
Network L|  Activate License...
Check for License Renewal...
Product N Server Expires License Number
10,200.20.19 - - E
(No IAR | Transfer License.., 10.200.20.219 - - I
B arm Deactivate License... SEUPP-AMBIORNL3 - 8890-867-322-7262
n% ARM SEUPP-BOER2 2017-08-0123:559 7700-245-387-5731
,,% TESTL Get Evaluation License... SEUPP-ERIKAD2 2019-11-10 23:59  B391-039-962-4145
d% TEST1 10 0T 01 SEUPP-ERIKAD2 2019-12-22 23:59 8891-118-930-0005
u@ TEST1 212 0/1 0f1 SEUPP-ERIKAD2 2019-11-10 23:55 8391-035-962-4145
,,% TESTL 212 0/1 0/1 SEUPP-ERIKAD2 2019-12-22 23::59  B891-118-930-0005
ﬂ% TEST3 110 0/1 0/1 SEUPP-ERIKAD2 2019-12-22 23:59 B8891-119-188-2184
2.10 0/1 0f1 SEUPP-ERIKAD2 2019-12-22 23:59 8891-115-188-2184

Feature Used Checkedout Limitations Expires

<

m ] »

Product details Server details

Server: 10.200.20.19

Server version: Unknown, incom

Scanning...

3 Select Online activation and click Next.

License Wizard ﬂ
i - GIAR
Activate License SEEME

@ Online activation

© Offline activation (if you do not have internet access)

Installation __¢
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4 Type your license number and click Next. You can find your license number in the
welcome letter in your product package.

License Wizard @
©IAR

SYSTEMS

Online Activation

Enter your license number:

1111-222-333-4444,

5 If you have not registered your license you will be asked to do that before proceeding.
If your license is already registered, go to step 10.

To register your license, click Register to register your license.

[
©IAR

SYSTEMS

License Wizard

Register your license

Before you can proceed with your activation, you must register your
license.

Register

‘When you are done registering the license, click Next.

18 Licensing Guide
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6 The License Wizard opens the IAR registration web page where you can register your
license.

% English « &3
SYSTEMS

Register License

License number
0858-238-888-8888

Product
IAR Embedded Workbench

Distributor
[14R Systems AB

First name

Last name
\

7 When you have completed the registration form, click Submit Registration. A
verification email will be sent to the address you specified.

SIAR
SYSTEMS

Please Confirm Registration

An email has now been sent to the address you specified (haiying.yuan@iar.com}), asking

you to confirm the registration. Follow the instructions in that email to receive information on
how ta proceed.

IAR Systems website
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8 Open the email when you receive it, and click on the link in the email to verify the
registration. The registration is now complete.

@ IAR English «
SYSTEMS

Registration Complete
Thank you for your registration!
You should now be able to proceed with your license activation.

NOTE: You mustfinish the license activation in the License Wizard before you can use your
product.

Ifyou still have your License Wizard open, just go backto it and click the Next button

Otherwise restart it from your application or from the |AR License Manager and proceed as
before.

IAR Systems

IAR Systems website

9 In the License Wizard, click Next to continue with the license activation.

10 Click Next to confirm that the license should be installed on the server shown.

License Wizard

Confirm server

Network licenses must be activated on the computer where the license
server is running. Confirm that the licenses should be installed on the
following server:

SEUPP (00.000.00.000)

20 Licensing Guide
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I I If your network license is using a dongle, you must now lock the license to the dongle.
(If your license will not use a dongle, skip this step.) Connect the dongle to your
computer, and make sure that no other dongle is connected. Click Next to continue.

temporarily lock the license to the computer while you
wait.

Otherwise make sure that the correct dongle is
attached and click Refresh dongle list.

[11 want to lock the license to this computer while | wait
for my dongle.

Troubleshaot

License Wizard ==
Confirm dongle ‘A :
g SYSTEMS
This license is locked to a dongle but no dongles were
found.
If you haven't received your dongle yet, you may -

Alternatively, if your dongle has not arrived, you can temporarily lock your license to
your computer. Select the corresponding checkbox.

You can lock the license to a dongle other than the one provided with the product
package, for example, if you want to lock several products to the same dongle. However,
you need to consider this carefully, because once the dongle is confirmed, the lock

cannot be undone.

12 The License Wizard now confirms your license details. Click Next to finish the

activation.

License Wizard

Confirm license details

Server. SEUPP
Locking eriteria; CPU Info String and Ethermet MAC Address
License model: Ternporary startup license

Click Next to activate this license
This may take more than a minute

SYSTEMS
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Note: Your temporary startup license might include a time-limited evaluation of
features that are not part of the license you have bought.

13 Your network license is now installed. In the IAR License Manager, click Done to
close the License Wizard. The license server will be running in the background, and
you can use the IAR License Manager at any time to view or manage the licenses.

14 When you have finalized your IAR product purchase, you will receive email
notification from IAR that your permanent license is available.
C. ACTIVATE YOUR LICENSE FOR PERMANENT USE

When you receive email notification from IAR that your permanent license is available,
you can activate your license for permanent use.

If the license server computer does not have an internet connection, you can activate
your license offline, see Activating a license when offline, page 35.

To activate your network license for permanent use:

I On the license server computer, start the IAR License Manager for License Server from
the Windows Start menu.

2 Choose License>Check for License Renewal.

Select the license for which you want to check for renewals.

 BTheck for License Renewals B~

Check License Mumber Product Expiry Date  Comment
5355-585-855-85888 AR Embedded Workbench Network license on this server (SEUPP-LETR)

[ shaw unused licenses
Select/deselect al licenses

[ Check selected licenses H Cancel J

4 Click Check selected licenses. The IAR License Manager contacts IAR to check
whether there are any renewals available for the selected license.

5 The Available Renewals dialog box is displayed and lists the licenses for which there
are new licenses available. Select the license you want to activate, and click Install
selected to install the license.
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Available Renewals [

License Number Product Comment
B533-855-385-8888 IAR Embedded Workbench New license

[ Install selected | [ cancel |

6 The Renewal Results are displayed. Click OK to close the License Wizard.

7 On the client computers, you might need to restart your IAR product or start the IAR
License Manager to detect the renewed licenses.

The permanent license of your IAR product can now be used.

D. INSTALL YOUR PRODUCT ON CLIENT COMPUTERS

When you have installed the IAR License Server Tools, and activated your network
license (temporary startup or permanent license), you can install your IAR product on
each client computer that the product will run on.

Note: Repeat these steps for each client computer that the product will run on.

Note: If you already have the new version of the product installed (an evaluation
version), go directly to step 5.

To install an IAR System product on a client computer:
|  Ensure the license server is up and running.
Run the installation program (autorun. exe) for the IAR System product.

Click Install to start the installation of your product.

H W N

Follow the instructions provided in the installation wizards and accept the license
agreements when prompted.

5 When you first start your IAR product on a client computer, it will find the license
server and ask you to confirm it. Click Yes. If the license server is not found
automatically, see Choosing a network license server manually, page 30.

You are now finished with the installation and the licensed product can be used.

23



Installing network licenses

Note: If you are upgrading from a size-limited IAR Embedded Workbench version,
make sure to perform a Rebuild All command when you build your project for the first
time using the new version.
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License management

This chapter describes how to perform some typical tasks for managing your
network, mobile and PC-locked licenses.

Managing your licenses

This section gives information about tasks that you might need to perform for your
network, mobile and PC-locked licenses. For some of the tasks there are also
step-by-step descriptions.

These tasks are covered:

Activating a license

Deactivating a license

Choosing a network license server manually
Starting and stopping a license server manually
Switching between different licenses for a product
Adding more users to a network license

Checking out a product for commuter authorization

Setting the maximum number of commuter authorizations
Some tasks can be performed offline:

e Activating a license when offline

e Transferring a license when offline

ACTIVATING A LICENSE
Before you can use your IAR product, you need to activate your license.

Follow these steps to activate your permanent network license, which has been
previously registered, when the license server computer is connected to the internet.

To activate (and register) your network license for the first time, see B. Activate your
temporary startup license, page 16.

To activate your license when the license server computer is offline, see Activating a
license when offline, page 35.

To activate a mobile or PC-locked license, see the Installation and Licensing Quick
Reference Guide.

25
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Note: Two network licenses for the same IAR product and package cannot coexist on
the same license server, with the later activated license overwriting the previous one.
The previous license can be reactivated on the same computer with the same locking
criteria. If you want to add more users to a network license, contact your IAR Sales

office.

To activate your network license:

I On the license server computer, start the IAR License Manager for License Server from

the Windows Start menu.

2 Choose License>Activate License to start the License Wizard.

) 14R License Manager 2.17.2 - License Server = | B e
File View | License | Tools Windows Help
Network L Activate License... -
Check for License Renewal...
. . -
Product Use Network License. .. Server Expires License Mumber
10.200.20.19 |E|
(Mo IAR | Transfer License... 10.200.20.218 - I
B arm Deactivate License... SEUPP-AMBIORNL3 - 8890-867-322-7262
,,%ARM SEUPP-BOER2 2017-08-01 23:59  7700-248-387-5731
%TESTI Get Evaluation License... SEUPP-ERIKAD2 2019-11-10 23:59 8891-039-962-4145
,,%TEFI'I o ot )8 SEUPP-ERIKAD2 2019-12-22 23:59 §891-118-930-0005
%TESTI 212 0f1 0/1 SEUPP-ERIKAD2 2019-11-10 23:59 8891-039-962-4145
,,%TEFH 212 of1 0f1 SEUPP-ERIKAD2 2019-12-22 23:59 8891-118-930-0005
,,%TESTE 1.10 0f1 0/1 SEUPP-ERIKAD2 2019-12-22 23:59 8891-119-188-2184
,,%TEFI'E 2.10 of1 0f1 SEUPP-ERIKAD2 2013-12-22 23:59  3891-118-188-2184

Feature Used Checked out Limitations Expires

<

m b

Product details

Server details

Server: 10,200.20.19
Server version: Unknown, incom

Scanning...

3 Select Online activation and click Next.




License Wizard &J
Activate Li GIAR
Clivate License SYSTEMS

@ Online activation

© Offline activation (if you do not have internet access)

welcome letter in your product package.

License Wizard ﬁ
Online Activati GIAR
niine Activation SYSTEMS

Enter your license number:

1111-222-333-4444]
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4 Type your license number and click Next. You can find your license number in the
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5 Click Next to confirm that the license should be installed on the server shown.

License Wizard @
Confirm server ©IAR
SYSTEMS

Network licenses must be activated on the computer where the license
server is running. Confirm that the licenses should be installed on the
following server:

SEUPP (00.000.00.000)

6 If your network license is using a dongle, you must now lock the license to the dongle.
(If your license will not use a dongle, skip this step.) Connect the dongle to your
computer, and make sure that no other dongle is connected. Click Next to continue.

License Wizard ==

GIAR
Confirm dongle SYSTEMS

This license is locked to a dongle but no dongles were
found.

If you haven't received your dongle yet, you may
temporarily lock the license to the computer while you
wait.

Refresh dongle list
Troubleshoot

Otherwise make sure that the correct dongle is

attached and click Refresh dongle list.

[711 want to leck the license to this computer while | wait
for my dongle.
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7 The License Wizard now confirms your license details. Click Next to finish the

activation.
License Wizard
Confirm license details GIAR
SYSTEMS
Server: SEUPP

Locking criteria: CPU Info String and Ethernet MAC Address
License model: Temporary startup license

Click Mext to activate this license
This may take more than a minute

8 Your license is now installed. In the IAR License Manager, click Done to close the
License Wizard. The license server will be running in the background, and you can use
the IAR License Manager at any time to view or manage the licenses.

DEACTIVATING A LICENSE

If required, you can use the IAR License Manger to deactivate a license, for example, if
you are transferring a license or merging several licenses, where you need to first
deactivate the license.

Note: To deactivate a network license locked to a license server computer, you must first
contact your local IAR Sales office or AR Customer Care team to request permission
for the transfer.

To deactivate a license:

I Inthe IAR License Manager, choose License>Deactivate to start the License Wizard.

2 In the list, select the product that you want to deactivate, and click Next.
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License Wizard @
Deactivate Li GIAR
eaclivale License SYSTEMS

Select the license you want to deactivate.

8888-888-888-8880 : IAR Embedded Workbench

8888-888-888-8380 : NW IAR Embedded Workbench

Click Next to deactivate your license.

w

Click Yes to confirm you want to deactivate the selected license.

4 Click Done to close the License Wizard.

CHOOSING A NETWORK LICENSE SERVER MANUALLY

From the IAR License Manger, you can manually choose the license server you want to
use for your IAR Embedded Workbench.

To manually choose a network license server:

I From the IAR License Manager for your product, choose Licence>Use Network
License to start the License Wizard.

2 If you have installed more than one product on the computer, you are prompted to
select the product that you want to use. Select the product and click Next.
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License Wizard ﬂ
GIAR
Choose a product SSIEME

Select the product you want to use a network license for.

IAR Embedded Workbench for RRRR
IAR Embedded Workbench for SSSS

T

3 In the list, select the server that you want to use and click Next.

[ License Wizard [==)
Choose server SIAR
SYSTEMS
Select the server you want to use for your |AR Embedded Workbench
for Arm. If your server is not in the list, you might have to click "Add a
server” fo add it to the list.
SEUPP-LMS2LIC (STD) Add aservey
SEUPP-BBBBB (STD)
SEUPP-AAAAA (CM)
Click Next to select the server for the product.
o

4 Alternatively, if the server is not in the list, click Add a server. In the dialog box that
appears, click Add and type the name or IP number of your server.
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Servers =

Use broadcasts to find servers

Found servers:
SEUPP-NICOLETR. -

SEUPP-LMS2NIGHT
SEUPP-AMBIORML3

SUPPBIONICTEST
SEUPP-ERIKAD2
10.200.21.59 ~Z

Manwally added servers:

Note: Entering an incorrect server name might slow down the IAR License Manager.
Click OK to return to the License Wizard.
In the License Wizard, select the server you want to use, and click Next.

The server is selected for the product. Click Done to close the License Wizard.

STARTING AND STOPPING A LICENSE SERVER MANUALLY

Normally, you do not need to start or stop the license server manually. It starts
automatically when the computer is started. If for some reason, you need to start the
license server, you can start the license server manually.

The license server runs as a Windows service. To find out if it is running, you can check
the Windows list of services. How to display that list depends on which Windows
version you are using. The service is called Sentinel RMS License Manager.

The executable file for the service is located where you installed the Sentinel RMS
License Manager during the installation of the IAR License Server Tools. The default
directory depends on Windows version and language, but would typically be something
like this: C: \Program Files\Common Files\SafeNet Sentinel\Sentinel RMS
License Manager

In that directory there is a subdirectory winNT where the server files are located. The
name of the server executable file is Lservnt . exe. To start and stop it, you run
loadls.exe (which requires administrator privileges).
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LoadLs 3|

This program will add or remove the Sentinel RMS License Manager to the ‘Windows NT
Swstem Service registry. You must have Adrministrator security privileges to uze this program
effectively.

To add the Sentinel RS License Manager as a System Service, confim that the
Executable Path field reflects the comect path to the executable file, lservnt.exe, and press
the &dd button,

Toremove the Sentinel RMS License Manager service from the System Service registry,
press the Remove button,

Executable Path

|E:\Program Files [8E]\Comman FileshS afeMet Sentinel\Sentinel RMS Licer

Remove
Cancel

b

Click Add or Remove to start or stop the service. If you click Add when the service is
already running, or Remove when the service is not running, you will get an error
message.

SWITCHING BETWEEN DIFFERENT LICENSES FOR A
PRODUCT

You can have several licenses for the same product installed on your computer. The
license that was most recently activated, will be the default license used.

Follow these steps to switch to another product variant, or to a network license.
To switch between different licenses for a product:

Start the IAR License Manager for your product from the Windows Start menu.
Choose View>Product List to list all installed products.

In the Product List page, double-click the product to display the License Details
dialog box showing detailed information about the licenses for the product.

In the License Details dialog box, select the license you want to use from the Selected
license drop-down list.
ADDING MORE USERS TO A NETWORK LICENSE

If the number of concurrent users permitted by your network license is not sufficient,
you can add more users to the license. To do this, you must contact your software
distributor or IAR to purchase an extended network license.
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H W N

You will get an email notification when your purchase is finished. To activate your
license with the new capacity, do one of these:

® Renewing a network license—looking for renewals for all activated licenses on the
computer. If you have many licenses installed this might take some time
(approximately one minute per license number). In this case, it might be better to
activate the license instead.

® Activating the license—renewing a specific license. You will need to specify the
same license number as when the original license was activated. One advantage
with this alternative is that only that specific license number is checked. This option
can also be used if renewals fail due to, for example, a changed locking criterion.

CHECKING OUT A PRODUCT FOR COMMUTER
AUTHORIZATION

You can check out a network license with commuter authorization to use your IAR
product for a limited number of days without being connected to the license server.

You can set the maximum number of commuter authorizations, see Setting the maximum
number of commuter authorizations, page 34.

To check out a product for commuter authorization.

Start the IAR License Manager for your product from the Windows Start menu.
Choose View>Product List to list all installed products.

Right-click on the product you want to check out, and choose Check out.

In the Check Out dialog box, specify how many days (maximum 15 days) you want to
check out a product with commuter authorization for.

You can now use the product without being connected to the license server.

To terminate the commuter authorization before it expires, right-click on the product
and choose Check in. Otherwise, the license will automatically be returned after the
specified number of days.

SETTING THE MAXIMUM NUMBER OF COMMUTER
AUTHORIZATIONS

By default, the maximum number of commuter authorizations is 100%, with no
restrictions. You can set the maximum number of commuter authorizations to a set
percentage of the total number of licenses, for example, 25%, using the LSERVOPTS
environment variable with the -com option on your license server computer:

LSERVOPTS=-com 25
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For information on how to check out a product for commuter authorizations, see
Checking out a product for commuter authorization, page 34.

ACTIVATING A LICENSE WHEN OFFLINE

You can activate a license even when the computer where the product or the IAR License
Server Tools are installed does not have an internet connection. However, you will still
need to access the internet using other means to contact IAR to request the license
activation.

Note: Two network licenses for the same IAR product and package cannot coexist on
the same license server, with the later activated license overwriting the previous one.
The previous license can be reactivated on the same computer with the same locking
criteria. If you want to add more users to a network license, contact your IAR Sales
office.

To activate your license on a computer which is offline, follow this procedure:

A. Request an offline activation

I On the offline computer where the product or the IAR License Server Tools are
installed, start the IAR License Manager from the Windows Start menu.

2 If you are using a license dongle, attach it to your computer.

3 Choose License>Activate License to start the License Wizard.

) IAR License Manager 2.17.2 - License Server = | E o)
File View | License | Tools Windows Help
Network L[ Activate License... -
Check for License Renewal...
Product A — Server Expires License Number
(Vo IAR | 10.200.20.19 - - E
(NoLAR| | Transfer License., 10.200.20.213 -
Barm D SEUPP-AMBIORNLE - 8390-867-322-7262
Barm SEUPP-EOER2 2017-08-0123:59  7700-249-387-5731
Bres1 Get Evaluation License... SEUPPERIKADZ ~ 2019-11-10 23:59 B8891-033-962-4145
BresTt 1O T SEUPPERIKAD2 ~ 2013-12-2223:59 B8391-118-930-0005
Bres1 212 o1 o SEUPPERIKADZ  2019-11-10 2359 8891039-962-4145
Bres1 212 o ot SEUPPERIKADZ ~ 2019-12-2223:59 8891-118-930-0005
BresTs 110 ot ot SEUPPERIKAD2 ~ 2013-12-2223:59 B8391-113-188-2134
Hrests 210 o1 o SEUPPERIKADZ ~ 2019-12-222359 8891-119-185-2184 _
Product detals Server details

Server: 10.200.20,18

Feature Used Checkedout Limitations Expires|
Server version: Unknown, incom

< n r

Seanning...
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4 Select Offline activation and click Next.

License Wizard =

SIAR
SYSTEMS

Activate License

© Online activation

@ Offline activation (if you do not have internet access)

5 Type your license number and click Next.

=

SIAR
SYSTEMS

License Wizard

Offline Activation

This wizard will help you to activate a license when the License Manager
cannot access the internet.

@ Generate an activation information file to send to IAR Systems.

License number:
The license number is usually in the format XOCOK-XOO-XO-XXXX.

© Use an activation response file from IAR Systems:

(=]

6 Specify whether the license should be locked to your computer or to a dongle.

If your license should be locked to a dongle, but you have not received it yet, select Yes,
but I have not received the dongle yet. You will then be able to lock the license
temporarily to your computer while you wait for the dongle.
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License Wizard @
ing criteri GIAR
Choose locking criteria SYSIEMS

Should the license be locked to a hardware dongle?

@ Yes
© No

‘@ Yes, but | have not received the dongle yet.

7 1If you chose to lock the license to a dongle directly (by selecting Yes in the previous
step) you will be asked to connect the dongle before proceeding.

Connect the dongle and click Refresh dongle list.

License Wizard =
Confirm dongle SIAN
SYSTEMS
No dongles were found. Make sure that the correct
dongle is connected and click Refresh dongle list.

[C] I want to lock the license to this computer while | wait
for my dongle.

8 Specify where to save the activation information file, then click Next. An activation
information file is created.
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License Wizard =

Save activation information

SYSTEMS

Choose where to save the activation information file.

GC:\Users\Public\ActivationInfo.txt E

9 As instructed, move the activation information file to a computer with an internet

connection.
License Wizard =
Request an activation response file SIAR

SYSTEMS
On a computer with internet access, go to the following web page:
https://register.iar.com/activate

Follow the instructions on the page. When asked for the activation
information file, specify your generated activation information file:

C:\Users\Public\Activation|nfo.bxt

Click Next when you have obtained the activation response file.

B. Notify IAR of the activation

I On a computer with an internet connection, go to
https://register.iar.com/activate
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Im
#
]

SIAR o

SYSTEMS

Offline License Activation

Use the Browse button below to navigate to the Activation Information file.
Then click Activate license

Browse..
: Activate license

Plgase nofe that the activabion procedure might take several minutes. Please be patient!

IAR Systems website

2 Browse to the activation information file you have moved to this computer, then click
Activate License to notify IAR of the license activation. (This may take several
minutes.)

3

If you have not registered your license you will be asked to do that before proceeding.

SIAR
SYSTEMS

Offline License Activation — Register License

The lipens:

n in ihe Acivalion Informakion e needs f be regisiend

T partorm tha registration, foliow tis ink (will opan in a new window,
« Register icense J980-096-008-0988

When e registralion is comgets, retum 1o his window and dice Activate license

Activate license |

Figass mofs Mal e sCHVaion DroCeoLTs miay ke seveval mInEss PIeass be Jabe

KR Systems website

4 At the end of the activation process, an activation response file is created. Click
Download response to download the activation response file.
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LgM English « B
SYSTEMS

Offline License Activation Granted
To download the Activation Response file, click Download response.
: Download response

Move the Activation Response file to the installation computer and finish the activation
process.

IAR Systems website

5 Move the activation response file to the offline computer where the product or the IAR
License Server Tools are installed.

C. Activate the license

I On the offline computer where the product or the IAR License Server Tools are
installed, click Next in the License Wizard.

2 Browse to the activation response file you moved to this computer, and click Next.

License Wizard =)

Use th file to activate the i GIAR
seine reSpOnSe lle 10 activate the license SYSTEMS

Browse to the activation response file from the previous step and click Next.

C:\Users\user\Documents\Activationinfo.bxt E]

The license has now been activated. Click Done to finish.

3 If you have temporarily locked your license to the computer and finally receive your
dongle, repeat the offline activation, but choose to lock the license to the dongle.
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4 1f your license is a temporary startup license, when you have finalized your IAR
product purchase, you will receive email notification from IAR that your permanent
license is available. You can then repeat the offline activation to activate your
permanent license.

TRANSFERRING A LICENSE WHEN OFFLINE

You can transfer a network or PC-locked license to another computer, even when the
computer where the license is installed does not have an internet connection, however,
you will still need to access the internet using other means to contact IAR to request the
deactivation of the license before transferring.

A transfer involves deactivating the license on the computer the license is being
transferred from, and then activating the license on the computer the license is being
transferred fo.

Note: To transfer or deactivate a network license locked to a license server computer,
you must first contact your local IAR Sales office or IAR Customer Care team to request
permission for the transfer.

Note: Two network licenses for the same IAR product and package cannot coexist on
the same license server, with the later activated license overwriting the previous one.
The previous license can be reactivated on the same computer with the same locking
criteria. If you want to add more users to a network license, contact your IAR Sales
office.

You can only transfer a PC-locked license up to three times during a 12-month period.

For information on transferring licenses when online, see the Installation and Licensing
Quick Reference Guide.

To transfer a license from an offline computer (X) to another computer (Y), follow this

procedure:

A. Request permission to deactivate

I On a computer with an internet connection, go to
https://register.iar.com/deactivate
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2 Type the license number you want to deactivate, and click Request deactivation.

— AR English - B&3E

SYSTEMS

Offline License Deactivation
Request deactivation
To request license deactivation, enter the license number below and click Request

deactivation,

License number:

Request deactivation

If you have already performed the reguest above, and are now refurning from the
installation computer with the Deactivation Confirmation file, click this link:
Confirm deactivation

IAR Systems website

3 When prompted, click Yes, proceed to proceed with the request deactivation.

% Englsh + BA3E
SYSTEMS

Offline License Deactivation

“You have requested
Are you sure?

of license 9-0:

Yes, proceed No, cancel

IAR Systems website

4 Your request for deactivation of the license is received, and a deactivation permission
file is created. Click Download Permission file to download the file.
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% English + B
SYSTEMS

Offline License Deactivation

Deactivation request r ived

“Your request for deactivation of the license 8855-880-088-8886 has been received.

To download the Deaclivation Permission file, click Download Permission file.
Download Permission file

Move the Deactivation Permission file to the computer where the IAR Systems product is

installed and start the 1AR License Manager. On the License menu, choose Offline License

Transfer and follow the instructicns.

Move the resulting Deactivation Confirmation file back here and proceed by clicking Confirm
Deactivation.

Confirm Deactivation

IAR Systems website

Move the deactivation permission file to the computer where you want to transfer the
license from (computer X).
B. Perform the offline transfer

On the original computer where you want to transfer the license from, start the IAR
License Manager from the Windows Start menu.

Choose License>Transfer License to start the License Wizard.

Select Offline transfer and click Next.

License Wizard @
Transfer Li GIAR
ranster License SYSTEMS

2 Online transfer

@ Offline transfer (if you do not have internet access)
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4 Browse to the deactivation permission file you have downloaded and moved to this
computer, and click OK.

Transfer License Offiine B

On a computer with internet access, go to
https://register.iar .com/deactivate to get a deactivation permission fie.

Browse to the file with the Deactivation permission and dick OK.

Browse...

5 Your license was deactivated on this computer. Click OK to create a deactivation
confirmation file.

LicenseManager X

Your license was successfully deactivated on this computer.
The next step is to save a confirmation file and take itto a
computer with internet access. Go ta
https://register.iar.com/deactivate on that computer and
upload the file.

6 Move the deactivation confirmation file to a computer with an internet connection.

C. Notify IAR of the deactivation

I Return to the web page https://register.iar.com/deactivate, and click Confirm
Deactivation.
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= IAR Engiish + H4E
SYSTEMS

Offline License Deactivation

Deactivation request received

Your request for deactivation of the license 8538-889-988-8888 has been received.
To download the Deactivation Permission file, click Download Permission file.

Download Permission file
| owToad Tormeson e |

Move the Deactivation Permission file to the computer where the IAR Systems product is
installed and start the IAR License Manager. On the License menu, choose Offline License
Transfer and follow the instructions.

Move the resulting Deactivation Confirmation file back here and proceed by clicking Confirm
Deactivation.

Confirm Deactivation

IAR Systems website

2 Browse to the deactivation confirmation file you have moved to this computer, then
click Post confirmation to confirm the license deactivation with IAR.

SIAR e
SYSTEMS

Offline License Deactivation

Confirm Deactivation

Use the Browse button below to navigate to the Deactivation Confirmation file.
Then click Post confirmation

No file selected.

Post confirmation

IAR Systems website
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3 Your license has been deactivated.

@IAR English - B
SYSTEMS

Offline License Deactivation Successful

The license 8888-888-888-8888 has been successfully deactivated

IAR Systems website

4 In the License Wizard, click Done to finish.

D. Activate the license

I On the new computer which you want to transfer the license ‘o, start the IAR License
Manager from the Windows Start menu.

2 Choose License>Activate License to start the License Wizard:

e If the computer is online, follow Activating a license, page 25

e If the computer is offline, follow Activating a license when offline, page 35.

Reserving user groups for network licenses

You can create a reservation file that specifies groups of users that have exclusive right
to use a feature, and groups that may not use a feature.

To create a reservation file that specifies user groups for network licenses:

I Edit the user group file using a text editor. Use this file syntax:

feature name, feature version:group name:reserved tokens:user_1

user_N
where:
feature_name is for example, XXX . EW.COMPILER_STD.
feature_version is for example, 1.01.
group_name is a name that identifies the group.
reserved_tokens is the number of license users reserved for the group.
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user_1...user_N is a list of user names or host IDs, separated by white
space. Use these characters to restrict or allow user access:

$, identifies a computer name, which can be a computer
name or an [P address (IPv4 only)

1, alogical NOT
*,a wildcard for any one or more characters
For example:

Scomputerl
$10.11.0.*
John.Smith
!David.Smith

For example, this file will make the server hold two tokens exclusively for users at
workstations PC-ADAM and PC-ADA, for the compiler and debugger features, while
the user of PC-GUEST will be unable to use the specified features at all:

XXX .EW.COMPILER_STD,1.01l:include_grp:2:$PC-ADAM $PC-ADA
XXX .EW.COMPILER_STD,1.01l:exclude_grp:0:$PC-GUEST
XXX .EW.DEBUGGER_STD,1.01:include_grp:2:$PC-ADAM $PC-ADA
XXX .EW.DEBUGGER_STD, 1.01:exclude_grp:0:$PC-GUEST

Note that a license normally has a number of features. You can find the feature names
and versions in the IAR License Manager. Double-click a product to open the License
Details dialog box.

Save the file, for example, as
C:\IARSystems\LicenseManagement\lreserv. txt.

Use the LSRESERV environment variable to set the destination of the user group file.
For example: LSRESERV=C: \IARSystems\LicenseManagement\lreserv.txt
Restart the license server.

Note: You must restart the server after making any changes to the file Ireserv.txt.
Using the license is now restricted according to your specification:

e If the number of reserved tokens for the group is the same as the number of users
allowed for the license, no one outside the group can use the license.

e If the number of reserved tokens for the group is zero, no one in the group can use
the license.
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Logging license server activities

You can log a license server’s activities. Typically, this is useful for monitoring which
users are using which licenses and how much.

These topics are described:

Activating logging for the IAR License Manager for License Server, page 48

Activating logging using an environment variable, page 49

°
°
o Specifying the size of the log files, page 49
® Backing up the log files, page 49

® Disable backing up log files, page 50

For information on the log file format, see Log file format, page 62.
ACTIVATING LOGGING FOR THE IAR LICENSE MANAGER
FOR LICENSE SERVER

You can activate the logging of server activities using the IAR License Manager for
License Server.

To activate logging of server activities:
I Start the IAR License Manager for License Server from the Windows Start menu.
2 Choose Tools>Options.

Select Log server activities, specify the filename and the location of the log file, and
click OK.

Options &J

Enable All Dislogs

Some dialog boxes can be suppressed by selecting a "Don't show again” check box. Click
"Enable All Dialogs™to enable all suppressed dialog boxes again.

V| Log server activities
C:\ProgramData\[ARSystems\LicenseManagement'\Diagnostics\ServerLog. txt -
The log settings must be set on the server computer and will take effect the next time the

license server is restarted. Changing the log file requires that you allows the Registry
Console Tool to make changes in the registry when you press Ok.

o
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You must make these settings on the server computer and they will take effect the next
time the license server Windows service is restarted. To modify these settings, you must
start the IAR License Manager as an administrator.

ACTIVATING LOGGING USING AN ENVIRONMENT VARIABLE

You can activate the logging of server activities by setting an environment variable on
the license server computer:

LSERVOPTS=-1 path_to_log file

For example:

LSERVOPTS=-1 C:\ServerLog\logfile.txt

You must restart the license server Windows service for the changes to take effect.

Note: If the environment variable is set globally, for example in Windows system
properties, it might affect other products.

SPECIFYING THE SIZE OF THE LOG FILES

Use the -z option to specify the maximum size of the log file. The size can be specified
in bytes, for example -z 2000 for 2000 bytes, in kilobytes, for example -z 2k for two
kilobytes, or in megabytes, for example -z 2m for two megabytes.

For example:

LSERVOPTS=-z 2m -1 C:\ServerLog\serverlog.txt

BACKING UP THE LOG FILES

If the maximum size of the file is reached, as specified by the -z option, the license
server copies (renames) the original log file to a backup file, which has the same name
but with two numeric digits appended to its name. The logging continues in the file with
the original name.

Example

The administrator has specified the maximum size of the log files as 2 Mbytes. When
the size reaches 2 Mbytes, the license server adds a suffix at the end of the log files. For
example: serverlog.txt.00, serverlog.txt.0l, serverlog.txt.02 up until
serverlog.txt.99. Once this limit is reached, the license server starts generating the
backup files using the same log file name series starting from 00, which means the old
log files will be overwritten.

If you need more log files, you must write your own script which will back up the first
100 log files to another location (storing the content), which means it is no longer a
problem when the first log files are overwritten.
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DISABLE BACKING UP LOG FILES

To disable the automatic backing up of log files, add the -x option to the LSERVOPTS
environment variable on the license server computer.
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Reference information

This chapter gives reference information about the IAR License Manager—a
tool for managing your IAR product licenses.

Reference information on the IAR License Manager

This section gives reference information about these windows and dialog boxes:

IAR License Manager main window, page 51
Available Renewals dialog box, page 55

Check for License Renewals dialog box, page 56
License Details dialog box, page 58

Options dialog box, page 60

Servers dialog box, page 61

IAR License Manager main window

The IAR License Manager is available from the Help menu in your IAR product, or
from the Windows Start menu.

T IAR License Manager 2.17.2 - IAR Embedded Workbench for Arm 8.40 — m] s
File View Llicense Tools Windows Help

Metwork Licenses ~  Product List X hd
.% |AR Embedded Workbench

Version 8.40

License number : 3883-833-333-8338

Commutable network license: SEUPP

Metwork license usage: 13%

(Double-click a product to see more details)

Use this window to manage your IAR product licenses.
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File menu

These commands are available:

Exit Exits the IAR License Manager.

View menu

These commands are available:

Refresh Updates network license usage information, dongle status,
etc. This is automatically done every 15 seconds.

Product List Opens the Product List page in the display area, which lists
all installed products. Double-click a product in the list to
display the License Details dialog box which shows
detailed information about the licenses for that product, see
License Details dialog box, page 58.

Network Licenses Opens the Network Licenses page in the display area,
which lists all available network licenses.

Network License Users Opens the Network License Users page in the display area,
which lists all users on the local network using network
licenses.

License Details Displays the License Details dialog box which lists detailed
information about selected licenses, see License Details
dialog box, page 58.

Servers Displays the Servers dialog box which lists all
automatically identified servers and manually added
servers. See Servers dialog box, page 61.

Dongle List Displays the Dongle List dialog box which lists all
connected dongles (Sentinel hardware keys).

License menu

These commands are available:

Activate License Starts the License Wizard where you can activate a license
using a license number, see Activating a license, page 25.
You can activate a license even if your computer does not
have an internet connection, see Activating a license when

offline, page 35.
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Check for License Displays the Check for License Renewals dialog box

Renewal where you can list any new versions available for selected
licenses, see Check for License Renewals dialog box, page
56.

Use Network License Starts the License Wizard where you can select the product

and server you want to use for a network license, see
Choosing a network license server manually, page 30.

Transfer License Starts the License Wizard where you can select a license
that you want to transfer to another computer. You can
transfer a license even if your computer does not have an
internet connection. See Transferring a license when
offline, page 41

Note that to transfer a network license locked to a license
server computer, you must first contact your local IAR
Sales office or AR Customer Care team to request
permission for the transfer.

Note that you can only transfer a PC-locked license up to
three times during a 12-month period.

Deactivate License Displays the Deactivate License dialog box where you can
select a license that you want to deactivate, see
Deactivating a license, page 29.

Get Evaluation License Starts the License Wizard where you can select a product

that you want to evaluate.

Tools menu
These commands are available:
Options Displays the Options dialog box, where you can re-enable

all previously suppressed dialog boxes, and activate logging
server activities, see Options dialog box, page 60.

Extract Optional Extracts source code libraries that were delivered with your
Packages product.

Windows menu

These commands are available:

Close Closes the currently selected page in the display area of the
IAR License Manager main window.
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Help menu

These commands are available:

Collect Diagnostic
Information

Installation and
Licensing Quick
Reference

Licensing Guide

About

Context menu (Product List)

Displays the Collect Diagnostic Information dialog box
and starts collecting diagnostic information. The progress is
displayed in the dialog box. When finished, click Explore
Results to view the collected diagnostic and license
management information. Typically, this information can be
useful if you contact IAR Support.

Opens the Installation and Licensing Quick Reference
Guide as a PDF.

Opens this Licensing Guide as a PDF.

Displays version information about the IAR License
Manager.

This context menu is available on the Product List page:

License Details...
Check in

Check out...

These commands are available:

License Details

Check in

Check out

Context menu (Network Licenses)

Displays the License Details dialog box which lists detailed
information about selected licenses, see License Details
dialog box, page 58.

Checks in a network license which you previously have
checked out with commuter authorization.

Checks out a network license with commuter authorization
which means you can use it as a PC-locked license for a
limited time.

This context menu is available on the Network Licenses page:

Check for renewals...

Delete...
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These commands are available:

Check for renewals Displays the Check for License Renewals dialog box
where you can list any new versions available for selected

licenses, see Check for License Renewals dialog box, page
56.

Delete Deletes the selected network license from the server. This
can only be performed on the license server computer.

A deleted network license can be activated anytime on the
same license server computer with the same locking criteria.

Note that the Delete command is not the same as the
Deactivate command, which deactivate the license from the
TIAR database.

Available Renewals dialog box

The Available Renewals dialog box is displayed when the Check selected licenses
button is clicked in the Check for License Renewals dialog box.

Available Renewals &J

License Number Product Comment
8888-583-888-8888  IAR Embedded Workbench New license

[ Install selected ][ Cancel ]

This dialog box lists any new versions available for the licenses selected in the Check
for License Renewals dialog box.

The IAR License Manager contacts IAR to check whether the local licenses are up to
date. If there are any new versions available, you will get the opportunity to renew them.

Display area

Lists licenses in these columns:

Checkbox Select the license you want to renew.

License Number The license number for the product.
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Product The name of the product.

Comment Information about the license.
Buttons

Install selected Installs the selected license.

Check for License Renewals dialog box

The Check for License Renewals dialog box is displayed when you choose
License>Check for renewals in the IAR License Manager, or when you choose Check
for renewals in the context menu of the Network Licenses page.

# B heck for License Renewals BT
Check  License Number Product Expiry Date Comment
B8888-588-888-8888 AR Embedded Workbench Network license on this server (SEUPP-LETR)

[] show unused licenses
Select/deselect all licenses

[ checkselectedlicenses | [ cancel |

This dialog box lists the currently used license for each installed IAR product on the
local machine, and the installed licenses on the local license server (if any). You can also
list unused licenses that have been installed and then deleted.

Display area

Lists licenses in these columns:

Check Select the license for which you want to check for new licenses
and click Check selected licenses. If there are any new
licenses, the Available Renewals dialog box is displayed. See
Available Renewals dialog box, page 55.

License Number The license number for the product.
Product The name of the product.

Expiry Date The date for the license expiration.
Comment Information about the license.
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Show unused licenses

Lists also unused licenses, in other words, licenses that are not currently selected for use.
Selecting Show unused licenses also lists network licenses that have been installed and
then deleted.

Typically, this option can be useful if you are using a temporary license that you have
received from IAR support. When you receive an update, you must select this option
before you can select your ordinary license for renewal.

Select/deselect all licenses

Selects or deselects all licenses listed in the display area.

Buttons

Check selected licenses ~ Checks whether there are any new licenses available for
the licenses selected in the Check column. If there are any
new licenses, the Available Renewals dialog box is
displayed, see Available Renewals dialog box, page 55.
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License Details dialog box

The License Details dialog box is displayed when you choose View>License Details
in the IAR License Manager, or when you double-click on a selected product or choose
License Details in the context menu of the Product List page.

.

License Details - [AR Embedded Workbench for Arm

==y
[ 1
Selected license: oK
MNetwork license: SELPP- - ]

Description:

Commuter
Installed product
IAR Embedded Workbench
Required license version: 1,12
Selected license
Server: SEUPP
License number: 8333-833-853-8383 Transfer License
License version: 1.12

Package file: C:'\ProgramData\lARSystems LicenseManagement'LicensePackages \EW\1\5elected. package Hide replaced
licenses

Features:

Feature Feature Name License Type Expires Limitations Status

IAR C/C++ Compiler EW.COMPILER_STD Metwork PERMAMNENT == Mot checked-out, 92 of 100 available

IAR C-RUN EW.CRUN_STD Network PERMAMENT Mot checked-out, 98 of 100 available

IAR C-STAT EW.CSTAT_STD Network PERMAMENT Mot checked-out, 98 of 100 available

IAR Debugger EW.DEBUGGER _STD Metwork PERMAMNENT Mot checked-out, 98 of 100 available

IAR Library Source EW.LIBSRC_STD Metwork PERMAMNENT Mot checked-out, 100 of 100 available

IAR Linker EW.LINKER_STD Metwork PERMAMNENT Mot checked-out, 92 of 100 available

IAR MISRA-C EW.MISRAC_STD Network PERMAMENT Mot checked-out, 100 of 100 available

Use this dialog box to choose between available licenses and to get detailed information
about the selected license.

Selected license

Lists all licenses that you have activated for this product and available network licenses.
Select the license that you want to use.

Description

Lists detailed information for the selected license.

Features

Displays all licensable features in the product and their license status in these columns:

Feature The name of the feature

Feature name The internal feature name.
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License Type The license type.
Expires Can be either:

The expiration date, for time-limited licenses
Permanent, for permanent licenses.

Limitations Limitations in, for example, time or size.

Status The status of the license; either OK or an error message.

Buttons

These buttons are available:

Check Out Checks out a network license with commuter authorization
which means you can use it as a PC-locked license for a limited
time.

Check In Checks in a network license which you previously have

checked out with commuter authorization.

Transfer License Deactivates the selected license, which can then be transferred
and activated on another computer.

Note that to transfer a network license locked to a license
server computer, you must first contact your local IAR Sales
office or IAR Customer Care team to request permission for
the transfer.

Note that you can only transfer a PC-locked license up to three
times during a 12-month period.

Hide replaced licenses

Hides replaced licenses. A license is replaced when you renew your licenses, for
example when you replace the startup license with the permanent license or when you
activated a later version. Note that the replaced licenses are still available.

59



Reference information on the IAR License Manager

Options dialog box
The Options dialog box is displayed when you choose Tools>Options in the AR
License Manager.

Cptions @

I Enable All Dialogs

Some dialog boxes can be suppressed by selecting a "Don't show again™ check box. Click
“Enable All Dialogs™to enable all suppressed dialog boxes again.

Log server activities
C:\ProgramData\[ARSystems LicenseManagement\Diagnostics\ServerLog, tet. E]
The log settings must be set on the server computer and will take effect the next time the

license server is restarted. Changing the log file requires that you allows the Registry
Console Tool to make changes in the registry when you press Ok,

L

Use this dialog box to enable all previously suppressed dialog boxes, and to activate
logging server activities.

Buttons

Enable All Dialogs  Enables all previously suppressed dialog boxes.

Log server activities

Activates logging of a license server’s activities. Typically, this is useful for monitoring
which users are using which licenses and how much. See Activating logging for the AR
License Manager for License Server, page 48.
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Servers dialog box
The Servers dialog box is displayed when you choose View>Servers in the IAR
License Manager.

5
Servers &J

|¥ Use broadcasts to find servers

Found servers:

SEUPP-LICENSE4 -
SEUPP-LICENSES

m

Manually added servers:

Add
_ o |
oo |

Cancel

Use this dialog box to manually point out license servers that the IAR License Server
for some reason does not automatically detect.

h

Note: Manually added non-existing servers will seriously increase response times in the
IAR License Manager.

Use broadcasts to find servers

Enables broadcasts to find servers automatically on a subnet. If you disable this option,
you must manually add the servers that you want to use. All references to automatically
found servers will be removed.

Found servers

Lists automatically detected license servers.

Manually added servers

Lists manually added license servers.

Buttons

These buttons are available:

Add Adds a license server to the list. Click Add and type the name
or IP number of the license server that you want to add.

Edit Edits the name of an already added license server. Select a
license server and click Edit to edit the license server.
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Remove Removes an already added license server. Select a license
server and click Remove to remove the license server.

Log file format

Licensing Guide

If logging of a license server’s activities is activated, the information is recorded in a log
file, one entry per line.

For information on how to log a license server’s activities, see Logging license server
activities, page 48.

The log file is in this format:

Element Description

Server—LFE Customer-defined log file encryption level as specified by the license
server -1 fe option.

License—LFE Vendor-defined log file encryption level. If this is non-zero, this element
overrides Server—LFE.

Checksum A checksum for the entry.

Date The date the entry was created, in the format: Day Month Date
(hh:mm:ss) Year, for example Wed Jan 10 08:40:46 2018.

Time-stamp The timestamp of the entry.

Feature The name of the feature.

Ver The version of the feature.

Trans The transaction type.

Explicit entries:

0 - A license is issued.

1 - Alicense is denied.

2 - The licensed application released the license token (when the
release APl is called)

8 - A commuter license is checked out.

9 - A commuter license is checked in.

17 - Explicit request entry of a shared license token

18 - Explicit release entry of a shared license token

Implicit entries:

10 - Implicit license release entry when the License Manager performs
cleanup of in use keys before shutdown.

11 - Implicit license release entry when the License Manager reclaims
tokens after the key lifetime period has expired.

Table 2: The log file elements
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Element Description

Trans (Continued) 12 - Implicit license release entry when any of the following
transactions takes place:

* License A is released at midnight when license switches to License B.

*The license is released after actual revocation takes place for a deferred
revocation case.

* License A is released when License B is dynamically added.

13 - Implicit license release entry when the usage log file is changed

under any of the following scenarios:

* When the backup usage log file is created (in case of overflow), a
license release entry in the backup log file.

* When the log file is changed by calling the usage log function
VLSchangeUsageLogFileName, a license release entry in the
previous log file

14 - Implicit license request entry under the scenarios when update

calls are converted into request. For example:

* When clients are running and the heartbeat message is sent after the
License Manager restart

* When heartbeat messages are sent after the key lifetime expiration

15 - Implicit license request entry under any of the following scenarios:

* When the backup usage log file is created (in case of overflow), a
license request entry in the new log file.

* When the log file is changed by calling the usage log function
VLSchangeUsagelLogFileName, a license request entry in the new
log file.

16 - Implicit release entries in the usage log file of the follower server,

when the original leader comes back after going down (in the case of

redundant License Manager setup).

Numkeys The number of licenses in use after the current request/release.
(Encrypted if encryption level is set to 3 or 4.)

Keylife How long, in seconds, the license was used. Only applicable in a license
release entry.

Table 2: The log file elements (Continued)
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Element

Description

User

Host

LSver

Currency

Comment

Queue key ID

Absolute position

Group position

The user name of the application associated with the entry.

This element can be logged anonymously if the anonymous logging
option is set.

If the License Manager is not started with the extended log option,
LM_SERVER appears as the user name.

If the License Manager is started with the extended log option, the
actual user name appears in the user name field of each dummy record.
If clients are connected to the License Manager when the backup file is
created, dummy records are created only for in-use license tokens in
the backup file (and not for the tokens whose key lifetime has expired).
Correspondingly, their dummy records are created in the new file. the
dummy entries are differentiated from the rest of the entries by specific
transaction IDs (13 and 15).

The host name of the application associated with the entry.
This element can be logged anonymously if the anonymous logging
option is set.

The version of the Sentinel RMS Development Kit license server.

The number of licenses handled during the transaction. (Encrypted if
the encryption level is set to 3 or 4.)

The text passed by the license application.

This element can be logged anonymously if these conditions are met:

* Anonymization of comments is allowed in the licensed application.

* The system administrator has set the License Manager anonymous
logging option.

Further, the comment can be fully or partially anonymized depending

on the vendor's implementation.

If license queuing is enabled, this value denotes the queue ID—a unique
identifier of the queued key. Otherwise, it contains a hyphen as in the
example below.

If license queuing is enabled, this value denotes position of the queued
client in the queue. Otherwise, it contains a hyphen as in the example
below.

If the system administrator has created a group reservation file and
license queuing is enabled, this value denotes the position of the queued
client in its group. Otherwise, it contains a hyphen as in the example
below.

Table 2: The log file elements (Continued)
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Element Description

Group name If the system administrator has created a group reservation file and the
queued key is granted from the reserved group, (as specified in the
reservation file) the group name will appear. Otherwise, it contains a
hyphen as in the example below.

Queue length If license queuing is enabled, this value denotes the queue length—the
total number of clients existing in the queue at that particular time.
Otherwise, it contains a hyphen as in the example below.

Capacity flag 0 - Capacity licensing is not used.
1 - Capacity licensing is used.

License capacity If capacity licensing is used, this field contains the license capacity.
Otherwise, it contains a hyphen as in the example below.

Team capacity If capacity licensing is used, this field contains the team capacity.
Otherwise, it contains a hyphen as in the example below.

User capacity If capacity licensing is used, this field contains the user capacity.
Otherwise, it contains a hyphen as in the example below.

Record number Encrypted record number

Client ID A 16-byte value that uniquely identifies each client request and is logged
in the following transaction types: 0, 2, 10, | I, 12, 13, 14, 15, 16, 17, and
18. Using the client ID, each request log entry can be mapped with the
corresponding release log entry.

Also note the following behavior:

*The client ID is shown in extended logs only. In plain logs, a hyphen will
be logged instead of the client ID.

*The client ID will not be maintained for commuter and queued clients.
In such cases, a hyphen will be logged instead of the client ID.

* For clients earlier than v8.5.5, the client ID in the case of transaction
ID 14 will not be maintained, instead a fresh client ID will be
assigned.

Readable checksum Readable checksum of the record

Encrypted checksum  Encrypted cumulative checksum

Table 2: The log file elements (Continued)
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A typical entry might appear as:

# Startup Sentinel RMS License Manager v8.6.0.0036 Mon Aug 25
15:36:27 2014 1408961183 Machinel 197 1708

2 1 ODA= Mon Aug 25 15:36:27 2014 1408961187 f1 vl 0 1 0 JSmith
Machinel 8.6.0.0036 1 request_comment - - - - - 0 - - - MA==
3724690 MTQxMjYANTg3Nw==

# Shutdown Sentinel RMS License Manager v8.6.0.0036 Mon Aug
2515:36:43 2014 1408961203 Machinel 1708 Mg== 522318

If the License Manager is started with extended log option, an entry in the log file might
appear as:

# # Startup Sentinel RMS License Manager v8.6.0.0036 Mon Aug 25
15:22:34 2014 140890354 Machinel 25 5976 v2.0 437875

2 1 ODA= Mon Aug 25 15:27:55 2014 1408960675 f1 vl 15 1 0 JSmith
Machinel 8.6.0.0036 1 request_comment - - - - - 0o - - -
3fd76b2d23b445e5a1e253068b3f1 MA== 295147 NzMzMDIO

Shutdown Sentinel RMS License Manager v8.6.0.0036 Mon Aug 25
15:28:48 2014 1408960728 Machinel 5976 Ng== 642326 OTclMjUx
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This chapter lists terms related to licensing.

Commuter authorization
A network license that you can check out from the server and
use as a PC-locked license for a limited time.

Entitlement

The features your license entitles you to. In other words, the
features that will be enabled and the period they can be used
for.

Evaluation license

A free license that is limited in time or in function. For a
time-limited evaluation license, the same product version can
only be evaluated once on a specific computer.

Feature

A feature in the installed software that is enabled or disabled
depending on the entitlement in your license. There is a license
key for each feature.

License activation
The procedure to get the license keys from IAR.

License key
A string that contains information that allows the license to
verify your entitlements.

License number
A unique identifier of a license, which is used in the license
activation and in contact with IAR support.

License package

License keys and license information stored in a file. A license
package is created on your computer when you activate a
license.

License registration
All licenses must be registered with IAR. During registration,
contact information about the license owner is collected, most

Licensing concepts __o

notably the email address. At the end of the registration
process an email is sent to the registered address to verify that
it is correct.

License server
A PC with the IAR License Server installed.

Mobile license

A single-user license that is locked to a dongle, and thus can be
used on any computer where the product is installed when the
dongle is connected.

Network license

A multi-user license that is located on a license server
computer. This license can be used by any computer on the
local network.

Offline activation

License activation requires the [AR License Manager to
connect to IAR over the internet. If that is not possible, there is
a backup routine called Offline activation.

PC-locked license
A single-user license that is locked to the computer hardware
and can be used on this computer only.

Permanent license
A license without a time limit.

Product

The product is what you have bought from IAR. In addition to
the software you have installed, the documentation, and
optionally a dongle, it is a license package that entitles you to
use a number of the features in the software.

Startup license

A time-limited license that you get immediately when you
activate your newly purchased product. Also known as a
temporary startup license.

Transfer license
Deactivating a license and returning it to IAR, to be able to
reactivate it on another computer.
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